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CHAPTER I 
 

 

INTRODUCTION 

Tissue Engineering is an interdisciplinary field involving life sciences and 

engineering dealing with regenerating tissues and organs to replace or support the 

function of defective body parts for the betterment of humankind.  According to Organ 

Procurement Transplantation Network (OPTN) the number of patients waiting for organ 

transplant as of November 2010 was 109971 whereas the number of transplants that 

occurred in period January - August 2010 was only 19249.  This difference between 

demand and supply has created the need for Tissue Engineering.  

Fabrication of tissues in the laboratory environment requires engineering of 

scaffolds, cells and biologically active molecules (biofactor) like proteins, peptides and 

carbohydrates.  Scaffolds are three dimensional synthetic frame structures which serve as 

a mimic of extracellular matrix for cell adhesion, migration and proliferation.  A 

successful scaffold must meet the balance between mechanical function and biofactor 

delivery while providing sequential transition in which the regenerated tissue assumes 

functions as the scaffold degrades (Hollister 2005).  The scaffold should be 

biocompatible and promote growth and cell adhesion.  While the cells generate their own 

natural matrix elements, the synthetic matrix should degrade into non-toxic components, 

which can be eliminated from the body (Freyman et al. 2001). 
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Natural polymers such as chitosan, gelatin, fibrins, gluten and synthetic polymers 

such as polyvinyl alcohol (PVA), polylactic acid (PLLA), polyglycolic acid (PGA), poly 

(lactide-co-glycolide) (PLGA) are used in scaffold preparation.  The interest in natural 

polymers was generated due to their biocompatibility, availability and ease of processing.  

However, natural polymers suffer from problems like cross contamination, batch to batch 

variations and high price (Mark Saltzman and Baldwin 1998).  Hence, the reproducibility 

of scaffold characteristics with natural polymers, such as mechanical strength, is of a 

concern.  On the other hand, synthetic polymers can be manufactured by aiming at 

specific properties, like mechanical property, surface morphology, porosity, without 

encountering major obstacles.  However, the disadvantage of synthetic polymers is the 

lack of cell recognition signals (Kim and Mooney 1998).  Designing and development of 

scaffolds from different materials has been studied extensively (Yang et al. 2001; 

Courtney et al. 2006; Liu et al. 2007; Cheng  et al. 2008).  Also, generating natural 

scaffolds from different tissues after removing cells are explored.  For example, scientists 

have developed scaffolds from the liver by removing the cells and retaining the 

extracellular matrix and vascular channels (Uygun et al. 2010). 

Tissue engineering can be performed via two approaches namely in situ and in 

vitro.  In situ technique utilizes natural healing mechanism by implanting the scaffolds 

without cells inside the body and relying on migration of cells from the neighboring 

tissues on to the scaffold.  In contrast in vitro technique utilizes cell culture conditions by 

seeding cells on to the scaffold outside the body and allowing the cells to establish cell-

composite grafts followed by in vivo implantation of the grafts.  This process has to be 

executed aseptically under physiological temperature, pH with sufficient amount of 
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nutrients.  Since a significant number of cells are required to colonize 3D porous 

structures in seeded technique, bioreactors are utilized as a way to distribute the nutrients 

within the biodegradable porous structures. 

Bioreactors of different configurations and flow systems have been utilized for 

regenerating tissues in seeded technique (Martin et al. 2004; Martin and Vermette 2005; 

Cummings and Waters 2007).  Some studies have shown an improvement in the quality 

of the regenerated tissue (Niklason et al. 1999).  However, other studies have shown 

deterioration in the quality of the tissue (Heydarkhan-Hagvall et al. 2006).  The 

mechanical stimulus needed by the cell for accelerated growth is provided by the fluid 

flow inside the reactor (Powell et al. 2002; Vance et al. 2005).  Fundamental concepts in 

developing these reactors are not well defined.  For example, many tissues such as skin, 

bladder, and cartilage have a high aspect ratio (large surface area relative to the 

thickness).  In these systems, one has to understand the fluid distribution and the effect of 

shape of the reactor (Heydarkhan-Hagvall et al. 2006), as non-uniform flow patterns 

within the reactor lead to poor quality of regenerated tissues via multiple modes, i) poor 

distribution of nutrients, and ii) non-uniform shear stress distribution, which affects the 

structure as well as the assembly of extracellular matrix (ECM) elements.  Further, tissue 

regeneration is a dynamic process where the porous characteristics change due to cell 

growth, newly deposited matrix components, and degradation of the porous architecture.  

These changes affect the transport characteristics.   

To better understand the effect of fluid flow in bioreactors, few studies are 

performed using computational fluid dynamics tools in high aspect ratio bioreactors.  One 

of the previous studies suggested the possibility of using (Devarapalli et al. 2009) a 
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circular shape parallel plate flow-through reactor for uniform nutrient distribution.  

Nutrient consumption patterns were studied for various cells types along with flow 

pattern and residence time distribution analysis. 

Although these designs showed some advantages, they have certain drawbacks.  

Since the fluid is flowing through the porous structure, maximum allowable flow rate is 

restricted by the mechanical characteristics of the porous structure.  High flow rates 

necessary during healing could damage the regenerating tissue.  Further, flow rate 

through the scaffold microarchitecture dictates the local shear stresses to which cells are 

exposed to.  High shear rates could be detrimental to the cells and to the assembly of 

newly synthesized matrix elements.  Hence, there is a need to evaluate alternative 

configurations for this design. 

In this study, alternatives to the circular reactor shape design are evaluated along 

with varying thickness of the porous structures.  Then the effects of changing porous 

characteristics during tissue regeneration, attributed to de novo synthesis of matrix 

elements and cell colonization, are also evaluated.  The two specific aims of this study 

are: 

Specific Aim 1: To determine alternate design for a flow through bioreactor. 

Two new designs of split flow parallel plate reactor were considered.  The 

simulation was carried out using COMSOL Multiphysics 3.5a (COMSOL, Inc., 

Burlington, MA).  The flow of the system was analyzed by using Navier-Stokes 

equations in non-porous region of the reactor and Brinkman equations in the porous 

region of the reactor.  The steady state momentum transport was utilized in the 

convective diffusion equation to obtain the concentration profiles.  Metabolic 



5 
 

consumption of oxygen and glucose was included using Michaelis-Menten kinetic rate 

laws.  Along with differential pressure, shear tress distribution inside the bioreactor was 

analyzed.  Péclet number was calculated at various locations inside the bioreactor for 

determination of flow regime.  It was observed that the nutrient distribution inside the 

scaffold occurs only due to diffusion as the scaffold is placed at a lower level and 

nutrients flow over it.  

 

Specific Aim 2: To assess the effect of diffusivity changes on nutrient transport. 

Previous simulations were performed under constant diffusivity which may not be 

a factor when nutrient distribution is primarily by convective flow i.e., when Péclet 

number is very high.  However, when the nutrient distribution is limited by diffusion, 

understanding the changes in diffusivity during regenerative process is important.  

Experiments were conducted to assess the diffusivity of glucose through chitosan-gelatin 

porous scaffolds of three different compositions using a custom-built apparatus 

(explained in chapter III) that accommodated4 cm × 4 cm sample.  Since the values of 

diffusivity were determined to be a magnitude higher than infinite diffusivity, the 

effective diffusion coefficient of nutrients through the porous scaffold was calculated 

using Mackie-Meares equation.  These values were incorporated in the reactor simulation 

using COMSOL Multiphysics 3.5a.  To find out the maximum scaffold thickness that 

could be fed using diffusive flow, further studies were performed by changing scaffold 

thicknesses.  Based on the results of concentration profiles of nutrients within the 

scaffold, the reactor was reconfigured with an extra inlet and outlet and with an extra 

channel to reduce the distance through which the nutrients had to diffuse.  Further, to 
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reduce the „Hold-up‟ volume of the reactor, the design was reconfigured by reducing the 

channel thickness.  This modified design was checked for varying thicknesses of scaffold.  

The comparison of minimum oxygen concentration, pressure drop and shear stress value 

indicated that the modified design gives higher values of minimum oxygen concentration 

for the same „hold-up‟ volume as compared to the first design which had only one 

parallel channel.  
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CHAPTER II 
 

 

LITERATURE REVIEW 

 

2.1 TISSUE ENGINEERING 

Tissue engineering has gained the importance because of the large gap between 

the organ acceptors and organ donors.  Tissue engineering offers the advantage of 

providing the functionally replaceable tissues widely and economically.  The general 

methodology of tissue engineering is based on two basic techniques, 

a) in situ regeneration of tissue 

b) Implantation of in vitro regenerated tissue 

With the in situ technique, a scaffold is implanted directly into the human body 

and the cells are allowed to grow naturally and carry out the healing procedure or cells 

are injected onto the scaffold and are allowed to multiply inside the human body.  There 

is much interest in the in situ growth of tissue from injected cells where mechanical 

stresses are applied naturally.  Blood vessels with superior mechanical properties have 

been grown in situ in an animal model using a natural scaffold that recruited endothelial 

cells (Griffith and Naughton 2002).  However, translating vascular successes in animals 
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to humans is difficult because human and animal endothelia behave very differently 

(Griffith and Naughton 2002). 

With the in vitro technique, the tissue is regenerated inside the glass.  The cells 

seeded on a scaffold are allowed to take the form of the scaffold.  The matured tissue is 

then implanted into the body (Figure 2.1).  With in vitro tissue engineering technique, 

tissue can be manipulated according to the requirement of the tissue to be grown and thus 

increases the chances of improvement of cellular binding. 

 

Figure 2.1: Schematic of in-vitro Tissue Engineering 

2.2 POROUS SCAFFOLDS: 

Materials which are biocompatible and can be transplanted in the body to replace 

or repair faulty organ or tissue are termed biomaterials.  To make biomaterials act as 
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extracellular matrix (ECM) elements, they are formed into a scaffold.  These scaffolds 

define a three-dimensional space for the formation of new tissues with appropriate 

structure, and guide the development of new tissues with appropriate function (Griffith 

and Naughton 2002).  While supporting biological activity, the scaffold degrades 

transiently and allows regeneration of tissue without any reminiscent foreign material 

(Langer and Vacanti 1993).  Some natural and synthetic polymers are used to generate 

such scaffolds.  Natural polymeric gels, such as collagen, alginate, chitosan, gelatin, 

polycaprolactone (PCL) have been used successfully (Risbud and Sittinger 2002).  This 

study considers chitosan and gelatin as basic biomaterials for production of the scaffold, 

as they have been studied earlier by our group.  Chitosan is a natural polymer derived by 

deacetylation of chitin, the primary structural element present in exoskeletons of shrimps 

and crab shells and cell walls of fungi.  Chitosan is an inexpensive natural polymeric 

material which has been used extensively for wound healing and drug delivery purposes 

(Chou. 2003; Ishihara et al. 2006).  Gelatin is a protein produced from bones, connective 

tissues and organs of animals like cows, horses and pigs.  Gelatin has been used 

previously for preparation of scaffolds (Mao et al. 2003). Some of the various attributes 

that make gelatin suitable as a biomaterial for tissue engineering are, low cost, good 

biocompatibility, biodegradability, low immunogenicity, increased cell adhesion, 

migration, differentiation and proliferation.  Gelatin is blended with chitosan to improve 

its biological activity, as it promotes cell adhesion, migration and forms a polyelectrolyte 

complex (Huang et al. 2005).  The backbone of gelatin has free carboxyl groups, enabling 

it to blend with cationic chitosan to form a network by hydrogen bonding (Thein-Han et 

al. 2009). 
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Preparation of scaffolds:  The techniques like fiber melts, fiber bonding, phase 

separation, solvent casting and particulate leaching (Yang et al. 2001), gas foaming, 

emulsion freeze drying, electrospinning, three dimensional printing (O'Brien et al. 2004; 

Hollister 2005; Reignier and Huneault 2006; Weigel et al. 2006) are commonly used for 

preparation of scaffolds for tissue engineering applications.  Every technique has 

advantages and disadvantages.  In this study controlled rate freeze drying and 

lyophilization technique (CRFLT) was employed for preparation of porous structures 

from chitosan and gelatin (Madihally and Matthwe 1999; Moshfeghian et al. 2006).  As 

CRFLT is carried out at low temperatures, the denaturation of biomaterials is avoided; 

also, CRFLT generates open pore architecture. 

In controlled rate freezing, a solution of polymer is prepared by dissolving the 

polymer in suitable solvent.  The solution is then frozen below the freezing temperature 

of solvent for around 6 hours to make sure that the solution solidifies.  Next the solidified 

solution is freeze dried in a lyophilizer.  This step allows the solvent to sublime leaving a 

porous structure behind.  Pores are obtained in the region where solvent crystals have 

solidified.  The alignment of crystal depends upon the direction of cooling.  Hence, 

uniform cooling from the surface is necessary to get uniform pores in the porous 

structure. 

Cells respond in a different manner to 3D porous structure than to 2D membranes.  

Also, the nature of porous structure, i.e. the porosity, pore size, pore number, mechanical 

properties, affects the cellular binding, cell migration and differentiation (Wake et al. 

1994; Van et al. 2002; Otsuki et al. 2006).  So, it is important to understand 3D 

characteristics of porous structure before every study. 
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Porosity:  Cells like high porosity.  The porosity and pore interconnectivity play a 

significant role in cell survival, proliferation, and migration (Lien et al. 2009; Mandal and 

Kundu 2009).  Higher porosity provides large surface area for the cellular interaction and 

extra cellular matrix regeneration.  Also higher porosity helps in better supply of nutrients 

across the scaffold. 

Pore size:  Pore size depends upon the technique of scaffold preparation from 

biomaterial solution and the concentration of the solution.  Pore size affects the amount 

of ECM formation.  The extent of ECM secretion also increases with increase in the pore 

size (Lien et al. 2009).  The average pore size of the scaffolds greatly affects the growth 

and penetration of cells in the 3D structure (Annabi et al. 2010).  Small pore size might 

hinder the nutrient supply, whereas it improves the retention of extra cellular matrix.  So, 

it is important to have an optimal pore size.  (Whang et al. 1999) found the optimal pore 

size for fibroblast in-growth is 5-15µm, for the in-growth of hepatocytes is 20µm, for 

regeneration of adult mammalian skin is 20-125 µm, and for regeneration of bone 100-

350µm.  As the cells grow and spread their ECM the pore size decreases. 

Topography: The surface characteristic of the scaffold is termed as its 

topography.  This property dictates the cell adhesion and cellular migration.  Certain cell 

types like smooth muscle cells and chondrocytes require high surface roughness whereas 

some require low surface roughness. 

Mechanotransduction: The signals or responses that are generated by the cells 

during regeneration phase or during working phase to the mechanical stimuli are termed 

as mechanotransduction.  The organs like blood vessels and heart, lungs, urinary bladder, 
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muscles inside the body are continuously under mechanical stress due to blood flow, air 

circulation, urine transport and due to weight of the body, respectively.  So, it is 

important to regenerate the tissues in the same conditions as they are exposed inside the 

body.  Certain in vitro studies point out that the flow of nutrients through the porous 

structure would dictate the shear stress inside the micro structure and these shear stresses 

instigate the signal transduction cascades that lead to altered gene expressions (Papadaki 

et al. 1999; Chiu et al. 2009).  The production of ECMs is also affected by the presence 

of flow through the scaffold on which the cells are growing.  Certain cells types like 

endothelial cells when growing on the scaffolds align themselves in the direction of the 

nutrient flow (Gray et al. 1988; Takahashi and Berk 1996).  Along with local 

hydrodynamic stresses, the cells also experience stresses due to contact inhibition and 

due to increased tissue density. 

 

2.3 BIOREACTORS IN TISSUE ENGINEERING: 

Bioreactors are needed to transform the research scale product designs to large 

scale production of biologically functional tissues that are reproducible, safe and 

economic (Chen and Hu 2006).  Bioreactors have been used to provide nourishment to 

the growing tissue on the scaffold as well as to provide the cells with the necessary 

mechanical forces.  The in vitro cultivation of 3D constructs in the bioreactor that 

efficiently provides nutrition to the cells, possibly combined with the application of 

mechanical stimulation to direct the cellular activity, differentiation and function, is an 

important step towards the development of functional grafts (Chen and Hu 2006).  
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Bioreactors are well established for the cultivation of microbes or mammalian cells under 

monitored and controlled environmental and operational conditions (e.g., pH, 

temperature, oxygen tension, and nutrient supply) up to an industrial scale (Portner et al. 

2005).  However the concepts of 2D cell culture cannot be applied to 3D tissue 

regeneration on porous scaffolds.  Also, an individualized bioreactor design will be 

needed for each type of tissue construct due to individualized requirements by the cells.  

Hence, there is a need to design tissue-specific bioreactors on the basis of comprehensive 

understanding of biological and engineering aspects.  Diffusion limitation, of nutrient 

mass transfer to the growing cells, has been one of the more important constraints the in 

bioreactor studies. 

Flow systems like rotating vessels, spinner flasks and flow through perfusion 

systems have been considered for increased proliferation of different cell types 

(Hoerstrup et al. 2000).  In general, cell culture bioreactors have to meet demands like 

cell to cell contact, surface for cell detachment, homogenous and low shear mixing and 

aeration, scale-up capability and ease of handling.  Some of the bioreactors utilized in 

tissue engineering are discussed below in brief: 

Rotating Shaft Bioreactor (RSB): The bioreactor (Figure 2.2) is oriented 

horizontally and has ports for culture media and gas perfusion which allow for 

continuous media replenishment and oxygen supply via surface aeration.  The half of the 

space in RSB is filled with media and the shaft is driven by a bidirectional peristaltic 

pump.  The rotation moves the scaffold constructs between gas and liquid phases in an 

oscillating fashion, thus leading to efficient oxygen and nutrient transfer.  Also, when the 

constructs are moving in the liquid phase, the construct movement relative to the medium 
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enables easier liquid penetration into the interior, thus enhancing the nutrient transfer and 

imparting more fluid-induced shear to the interior cells (Chen and Hu 2006). 

 

 

Figure2.2: Rotating Shaft Bioreactor (Chen et al 2006). 

 

Hollow Fiber Bioreactors: A hollow fiber reactor (Figure 2.3) consists of a 

closed vessel filled with culture media and mammalian cells into which a bundle of semi-

permeable hollow fibers is inserted.  The hollow fibers provide nutrients to the cells and 

eliminate their wastes, mimicking in vivo blood vessels.  The main advantage of using 

such a reactor is to provide nutrients to the center of the growing tissues (Martin and 

Vermette 2005).  This study shows that a large number of hollow fibers are needed to 

supply sufficient oxygen to obtain a homogeneous cell population.  A 1mm thick 

cartilage tissue has been reported for hollow fiber reactor, which is a marginal 

improvement as compared to cartilage tissues grown in stirred reactor configurations. 
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Figure2.3: Hollow Fiber Bioreactor. (Martin et al 2005) 

 

Perfusion Bioreactor:  Poor cell growth can be overcome by a perfusion system 

which is often in conjunction with chambers, columns or cartridges that hold the 

cell/scaffold constructs.  Direct perfusion bioreactors, where medium flows directly 

through the pores of the scaffold, can be used for seeding and culturing 3D constructs.  

During seeding, cells are transported directly into the scaffold pores, yielding a highly 

uniform cell distribution.  During culture, medium flowing through the construct 

enhances the mass transfer not only at the periphery but also within internal pores of the 

construct (Wendt, Marsano et al. 2003).  Problems associated with poor diffusion can be 

mitigated with a flow perfusion bioreactor in which media is forced through the scaffold 

pore network (Jaasma, Plunkett et al. 2008).  The flow of medium through the scaffold 

pores benefits cell differentiation by enhancing nutrient transport to the scaffold interior 

and by providing mechanical stimulation in the form of liquid shear (Holtorf, Sheffield et 

al. 2005). 
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Figure 2.4: Direct perfusion bioreactor. A) bioreactor system. B) cross-section of 

scaffold chamber. (Jaasma et al 2008). 

 

Parallel plate Bioreactor:  Parallel plate bioreactors have been studied (Reich 

and Frangos 1991; Koller et al. 1993) for observing the effects of flow, to maintain 

primary cells for cellular therapy and to investigate synthetic function of porcine 

hepatocytes (Shito et al. 2001).  Parallel plate bioreactors have not been studied in detail 

for culturing 3D tissues having large surface area.  In these reactors, the scaffold is 

subjected to hydraulic forces due to fluid flow and so the cells can experience 

micromechanical properties of individual fibers and local stresses within the porous 

structure (Devarapalli 2009).  The parallel plate design provides support to the scaffold 

and growing tissue as well as the circular shape of the reactor helps in eliminating the 

dead spaces. 
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2.4 CFD MODELING: 

 For the purpose of computation fluid dynamic modeling, the geometry of the 

object to be studied is drawn using CFD software.  This geometry is meshed for creating 

node points at which the equations will be solved.  Further, the governing equations of 

the process taking place in and around the model are integrated in the simulation and the 

simulation is run to get the results.  Computational Fluid dynamics has been used since 

long in chemical industry to simulate the flow of gases and liquids, movement of 

aerodynamic bodies, for heat transfer estimations and chemical reactions.  The flow of 

fluid through the bioreactors affects the cell adhesion, cell growth and proliferation and 

nutrient distribution (Singh and Hutmacher 2009).  So, the optimal flow conditions within 

a bioreactor should not be determined through a trial-and-error approach but rather 

should be supported by simulation methods (Martin et al. 2004).  To understand the 

influence of shear stresses on 3 D cultures (Porter et al. 2005) and (Raimondi et al. 2006) 

modeled the effects of perfusion.  These studies used Navier-Stokes equations to model 

the flows without considering the 3D structure.  In other studies (Chung et al. 2007) 

porosity based permeability was used to understand the fluid dynamics in a perfusion 

system.  While, (Boschetti et al. 2006) modeled flow through a 3D scaffold for predicting 

shear stresses acting on cells as a function of porosity, pore size and medium flow rate.  

However, all these studies were based on small cylindrical scaffolds and the flow 

characteristics were analyzed using Darcy‟s equations.  The Brinkman equation accounts 

for both viscous and drag forces in the porous medium and reduces to either the Navier-

Stokes equation or Darcy‟s law if either of the force becomes dominant (Capuani et al. 

2003).  In my study, I used Brinkman equation to study the flow dynamics within the 
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porous structure to mimic the tissue regeneration process.  I calculated the permeability 

based on the pore size keeping the number of pores constant and diffusivity of nutrient 

based on the porosity of scaffold.  However, porous characteristics change during tissue 

regeneration, i.e., permeability of the matrix decreases due to decrease in pore size. 

 Tissues, such as skin and bladder, have high surface areas.  So, to study tissue 

specific reactor conditions and to understand the flow dynamics, I designed high aspect 

ratio parallel plate bioreactors of a diameter of 100 mm and of varied thicknesses to 

evaluate the design of the bioreactor.  The concentration profiles of the nutrients and 

shear stresses over the porous structure were analyzed and the effect on tissue growth was 

checked. 
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CHAPTER III 
 

 

DETERMINATION OF ALTERNATIVE DESIGN FOR A FLOW THROUGH REACTOR 

 

3.1 Introduction: 

 In the flow through bioreactors the flow of nutrients has to pass through the entire 

scaffold.  Hence, the nutrient distributions and their sufficiency depend upon the flow rate of the 

medium carrying through the reactor.  Many flow through reactor configurations have been 

evaluated (Mueller et al. 1999; Bancroft et al. 2003).  One such configuration which utilized 

parallel flow through reactor (referred as Design 6 in the manuscript) had an advantage of 

uniform flow distribution (Devarapalli et al. 2009) in high-aspect ratio (100 mm diameter and 2 

mm thickness) porous structures.  However, the maximum allowable flow rate is restricted by the 

mechanical characteristics of the porous structure in flow through configuration.  High flow rates 

necessary during later stages of healing could damage the regenerating tissue.  Further, flow rate 

through the scaffold micro-architecture dictates the local shear stresses to which cells are 

exposed to.  High shear rates could be detrimental to the cells and to the assembly of newly 

synthesized matrix elements.  Hence, there is a need to find alternative configuration for a flow-

through reactor.  I evaluated two new designs (Design 7 and Design8) having „split flow‟ 

arrangement while keeping the diameter, porous structure thickness and inlet/outlet shapes 

constant. 
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Nutrient transport and consumption was investigated for regeneration of muscles tissue 

using smooth muscle cells (SMC) using kinetic constants reported in the literature.  The pressure 

drop, velocity and shear stress profiles analysis was done.  Further, simulations were performed 

for understanding the effect of changing pore size on account of proliferation of cells and de 

novo generation of extracellular matrix elements.  In addition, the previous study utilized 

chitosan-based 3D scaffold characteristics (Devarapalli et al. 2009).  However, recently it was 

reported that chitosan structures demonstrated reduced viability and proliferation as they lack the 

cell binding domain (Iyer 2009).  Alternatively, adding gelatin to the chitosan 3D scaffolds 

improved cell viability and cell function.  To incorporate these advances, I evaluated the reactor 

configuration for chitosan-gelatin porous structures. 

 

3.2 Materials and Methods: 

3.2.1 Sources of material 

Chitosan with molecular weight >310 kDa and 85% degree of deacetylation, Gelatin 

Type A (300 bloom) and glacial acetic acid were obtained from Sigma Aldrich Chemical Co (St. 

Louis, MO).  Ethanol (200 proof) was obtained from Aaper Alcohol and Chemical Company 

(Shelbyville, KY).  All other reagents were purchased from Fisher Scientific (Waltham, MA). 

 

3.2.2 Preparation of the scaffold: 

Chitosan-gelatin solutions were prepared in 0.1M acetic acid using deionized water.  A 

well of 100mm diameter was prepared on Teflon sheet using silicon glue and 25mL of chitosan-

gelatin solution was poured in the well and frozen overnight at -80
0
C.  The frozen solution was 

lyophilized overnight (Virtis, Gardiner, NY) to obtain porous scaffolds as shown in Figure 3.1.  
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The scaffolds obtained had thin non-porous layer on top.  This layer is termed as „skinny layer‟ 

and it could act as a barrier for the nutrient transport.  In case of scaffold made from (0.5%-0.5% 

wt/v) chitosan gelatin solution, this layer could be peeled off after the scaffold formation. 

 

Figure 3.1: Chitosan-Gelatin scaffold. 

3.2.3 Porosity and pore size: 

Obtained scaffolds were analyzed in dry condition using scanning electron microscope 

(SEM, Joel JSM 6360) at an accelerating voltage of 10 kV.  For this purpose, small sections of 

dry scaffolds were sputter-coated with gold at 40mA prior to observing under SEM.  

Morphologies of the scaffold were also characterized in hydrated condition using an inverted 

microscope (Nikon TE2000, Melville, NY) outfitted with a CCD camera.  Digital micrographs 

were captured at different locations and were analyzed for pore area, pore size (major axis) and 

shape factor using Sigma Scan Pro 5 software.  For each condition, more than 50 pores were 

analyzed. (Figure 3.2) 
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Figure 3.2: SEM images of Chitosan-Gelatin porous structure 0.5%-0.5%. 

To determine the porosity of the scaffold, 10 mm × 50mm strips were cut and the 

thickness was measured using Vernier calipers.  These strips were then weighed to get the dry 

weight.  Next, the scaffold strips were neutralized with absolute ethanol to remove acetic acid.  

In order to remove all the air bubbles from scaffold strips, they were cyclically pressurized and 

depressurized manually while keeping them immersed in ethanol.  These strips were weighed to 

find out their wet weight.  Porosity of the structure was obtained by using formula: 

εp =
𝑊𝑤𝑒𝑡 −𝑊𝑑𝑟𝑦

𝜌𝑒𝑡
× 100        (3.1) 

where, Wwet is the weight of the ethanol wetted scaffold strips, Wdry is the weight of the dry 

chitosan-gelatin scaffold strips, ρet is the specific gravity of ethanol. 

 

3.2.4 Alternative Designs: 

Two new designs were investigated having „split flow‟ arrangement (Figure 3.3).  These 

designs had a parallel channel to scaffold from where the nutrients would flow; 
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a) Design 7 had greater overall thickness of 4 mm, which allowed the nutrients to flow 

over a 2 mm open area (termed open channel) in addition to the 2 mm scaffold.   

b) In Design 8a, a 2 mm cavity was introduced to place the scaffold by only increasing 

the reactor thickness at the location of the scaffold to 4mm, while leaving the inlet and outlet 

extensions to 2 mm.  This modification was intended to protect the scaffold edges from the direct 

impact of the convective force while keeping the 2 mm open channel flow and 2 mm porous 

structure flow, similar to Design 7.  Cavity like configuration and has 2 mm thick inlet and outlet 

channels. 

 Design 6 was also simulated to compare the results and had an increased number of mesh 

nodes compared to previous reports. 
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Figure 3.3: Schematic of alternate reactor designs. (The gray region signifies the location of scaffold) 
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3.2.5 Simulating fluid flow in the reactor: 

The design geometries were created using COMSOL Multiphysics 3.5a (COMSOL, Inc., 

Burlington, MA).  For this purpose, work plane settings option in the draw tab was used; which 

allows drawing of a 2D reactor model that can be extruded to create a 3D reactor model in the 

3D model view.  Next, the sub-domain and boundary conditions were set in the Physics tab.  The 

steps similar as described in the manual given at the end of this manuscript were followed.  To 

create a uniformly sized fine mesh for getting accurate results, the central reactor portion was 

divided into 8 layers of 0.5 mm each.  The meshing of top most layer (boundary) was done using 

Free mesh parameters by selecting a triangular mesh type and by keeping maximum element 

size to 0.005m.  Then swept mesh parameter was used to mesh the whole geometry.  This 

technique gives increased number of nodes at which the Navier-Stokes equations are solved.  

Due to larger geometry of the new designs and the method of meshing, the number of Degrees of 

Freedom for Navier-Stokes equation and for convection and diffusion equations increased 

tremendously.  Therefore the simulation became memory intensive.  The computer which was 

used for simulation had a 1.86GHz Intel® Core™ 2 Duo processor with 32-bit Windows XP
TM

 

operating system.  This did not allow the full utilization of available RAM.  So, a 64-bit 

Windows Vista
TM

 Ultimate operating system was used. 

All simulations were performed under steady state conditions.  The inlet conditions were 

set according to 1mL/min flow, while the walls were described as smooth with no slip condition.  

The outlet of the reactor was set at atmospheric pressure.  The Reynolds number was calculated 

in the open channel region.  It was found that the Reynolds number was in the range of 0.16 to 

0.5.  Hence, the flow through the open channels of the design was in laminar flow region. 
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Fluid flow through the porous structure was modeled using the Brinkman equation, 

which is given as 

 𝜇∇2𝑢𝑠 −
𝜇

𝜅
𝑢𝑠 =  ∇𝑝        (3.2) 

 ∇. 𝑢𝑠 = 0          (3.3) 

where κ is the specific hydraulic permeability of the porous medium, us denotes the fluid 

superficial velocity vector, p is the fluid pressure, and μ the effective viscosity in the porous 

medium (Truskey et al. 2004).  The hydraulic permeability (κ) is a geometric characteristic of 

the porous structure at several length scales (Truskey et al. 2004).  The hydraulic permeability 

was calculated using 80μm and 140 pores/mm
2
 and by using the equation 

 𝜅 =  
𝜋

128
𝑛𝐴𝑑

4         (3.4) 

where nA is the number of pores per unit area and d is the pore diameter assuming that the pores 

are circular in shape.  The Navier-Stokes equations describing the flow in the open channel at 

steady state is given by 

 𝜌 𝑢. ∇ 𝑢 = −∇.  −𝜏 + 𝑝𝛿𝑖𝑗         (3.5) 

 ∇. 𝑢 = 0          (3.6) 

where, ρ is the fluid‟s density (kg/m
3
), p is the pressure (Pa) , δij is the Kronecker delta function, 

τ is the shear stress and is given by shear stress tensor equation 

 𝜏 = 𝜂 ∇𝑢 +   ∇𝑢 𝑇         (3.7) 
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where η is the dynamic viscosity (Pa-s) and u is the velocity in the open channel (m/s).  To 

account for the porous nature of the scaffold, the hydraulic permeability (κ) and void fraction 

(εp) were incorporated into equation (3.5) to give new form of Brinkman equation 

 
𝜂

𝜅
𝑢 = −∇.  

−𝜏

𝜀𝑝
+ 𝑝𝛿𝑖𝑗          (3.8) 

 

3.2.6 Simulating nutrient consumption in the reactor: 

Continuity equation in the chemical reaction engineering module of COMSOL 3.5a was 

solved to obtain the concentration profiles of oxygen and glucose by using results from steady 

state velocity profile of the nutrient flow in the reactor.  Concentration of nutrients at different 

locations inside the porous region was obtained by solving the convective diffusion equation. 

∇.  −𝐷∇𝑐𝐴 + 𝑢. ∇𝑐𝐴 = 𝑟𝐴       (3.9) 

where cA is concentration of the nutrient (mol/m
3
), rA is rate of reaction of the nutrient 

(mol/m
3
.s), D is the effective diffusivity of the nutrient (m

2
/s), and u is the velocity vector (m/s).  

Nutrient medium was assumed to have properties of water, as water constitutes most of the bulk 

phase.  The reaction term was only defined for the porous region of the reactor, i.e. only where 

the scaffold sits, as the cells would only be seeded on the scaffold. 

Michaelis-Menten rate law kinetics was used to define the consumption of both oxygen 

and glucose.  The rate law is given by the equation as follows, 

−𝑟𝐴 =
𝜈𝑚𝐶𝐴

𝑘𝑚 +𝐶𝐴
         (3.10) 

where rA is the reaction rate, vm is the maximum reaction rate, and km is the Michaelis-Menten 

constant.  In simulation, instead of cA oxygen is denoted at c1 while glucose is denoted as c2. 
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The kinetic parameters of for glucose consumption were retrieved from Alpert et al 

(Alpert et al. 2002) based on the cells cultured on tissue cultured plastic, while the kinetic 

parameters for oxygen were calculated using the partial pressure vs time plot by Motterlini et al 

(Motterlini, Kerger et al. 1998).  These kinetic parameters (Table 3.1) were calculated for cell 

density of 1.2×10
12

 cell/m
3
. 

Table 3.1: Kinetic Parameters for Smooth muscle cells (SMCs). 

Cell Type Oxygen Glucose Inlet concentrations 

 km(mol/m
3
) vm(μmol/m

3
.s) km(mol/m

3
) vm(μmol/m

3
.s) 

Oxygen 

(mol/m
3
) 

Glucose 

(mol/m
3
) 

SMCs 0.205 31.6 0.93 48.6 0.199 5.5 

 

The concentration of oxygen and glucose at the inlet is given as: 

𝑐𝑖 = 𝑐𝑖0,𝑖𝑛𝑙𝑒𝑡           (3.11) 

The initial concentration of oxygen in the growth medium was determined using the Henry‟s law 

constant at 37°C for each cell type. Initial concentrations of glucose were based on the growth 

media formulations used for populating SMCs.  Mass transport at the outlet was assumed to be 

dominated by convection with negligible contribution from diffusion i.e. 

𝑛. 𝑐𝑖𝑢 = 𝑟𝐴          (3.12) 

At all other boundaries, insulating conditions were specified as 

 𝜂.  −𝐷𝑖∇𝑐𝑖𝑢 = 0         (3.13) 

where Di is the diffusivity and ci is the concentration of particular nutrient i. 
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3.2.7 Physical properties and operating conditions for the reactor designs: 

 The nutrient medium used for providing nutrition to the cells has bulk amount of water.  

Hence, physical properties of the nutrient medium are assumed to be same as the physical 

properties of water at 37
0
C.  These values (Table 3.2) are used in the simulation. 

Table 3.2: Physical properties and operating conditions 

Property Value 

Density (rho) 1000 (kg/m
3
) 

Viscosity (eta) 0.006915 (N-s/m
2
) 

Pressure (Outlet) 1 atm 

Temperature 37
0
C 

 

3.3 Results and Discussion 

3.3.1 Effect of scaffold position inside reactor on pressure drop and shear stress: 

 The differential pressure and shear stress values for the Design 6 (Devarapalli et al. 2009) 

showed 47.5 Pa and 983 µPa, respectively.  When Deign 7 was evaluated (Figure 3.4), it was 

seen that the pressure drop across the reactor reduced to 0.014 mPa, while in Design 8a the 

pressure drop was 0.0471 mPa.  The shear stresses in Design 7 was (Figure 3.5) at a uniform 

low value of 45.8 µPa, while in Design 8a the shear stress had a uniform higher value of 193 µPa 

in the region where scaffold sits.  The increase in the shear stress in Design 8a can be attributed 

to the change in the thickness of the reactor.  Compared to Design 7, Design 8a can provide a 

higher uniform stresses which is favorable for tissue growth and regeneration.  Also the 

maximum shear stresses decreased from 442 µPa to 193 µPa in x-direction and from 983 µPa to 

249 µPa in y-direction in Design 8a as compared to Design 6. 
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In Design 6, the maximum shear stress values in x-direction were 442 µPa and 0.055 µPa 

at 1.5 mm and 0.5 mm from the bottom of the reactor respectively and shear stress values in y-

direction were 185.16 µPa and 185.2 µPa at 1.5 mm and 0.5 mm from the bottom of the reactor 

respectively.  Also the maximum velocity in x-direction (along the flow) were 3.804×10
-4

m/s, 

4.589×10
-4

m/s, 3.804×10
-4

m/s at 1.5 mm,  1mm and 0.5 mm thickness from the bottom of the 

reactor respectively in Design 6.  In Design 6, the flow of fluid is through the porous structure 

which explains the reason for the stress value to be near zero at the center of the porous structure.  

The difference in shear stresses between 1.5 mm and 0.5 mm can be attributed to the nature of 

velocity profile.  As the flow is not completely developed the velocity at 1.5 mm from the 

bottom is higher as compared to the velocity at 0.5mm from the bottom and hence higher value 

of stress. 

In Design 7, the shear stress values in x-direction were 240 µPa, 4.36 µPa, 3.86 µPa at 

2mm, 1.5mm and 1mm thickness from the bottom respectively.  The maximum shear stress 

values in y-direction were 139.5 µPa, 2.03 µPa, 1.0 µPa at 2mm, 1.5mm and 1mm thickness 

from the bottom respectively.  While the maximum velocity in x-direction (along the flow) were 

1.407×10
-4

m/s, 1.302×10
-4

m/s, 1.035×10
-4

m/s at 2mm, 1.5mm and 1mm thickness from the 

bottom of the reactor respectively in Design 7. 

In Design 8a, when the maximum shear stress values in x-direction were compared layer 

by layer it was observed that the values were 205 µPa, 0.014 µPa, 1.85×10
-3

 µPa at 2 mm, 1.5 

mm and 1mm thickness from the bottom of reactor respectively.  The maximum shear stress 

values in y-direction were 125 µPa, 0.9 µPa, 0.154 at 2 mm, 1.5 mm and 1mm thickness from 

the bottom respectively.  In Design 8a, also the maximum velocity in x-direction (along the 

flow) is 1.726×10
-6

m/s, 3.497×10
-7

m/s, 1.119×10
-7

m/s at 2 mm, 1.5 mm and 1 mm thickness 
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from the bottom respectively.  These low velocities in Design 8a can be attributed to the split 

channel nature of flow.  The shear stress values increase in the z-direction with top most layer 

being exposed to maximum stress.  This is in accordance with the shear stress developed due to 

Newtonian fluids.  Figure 3.6 summarizes the results.  
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Figure 3.4: Comparison of pressure drop in Design 6, Design 7 and Design 8a at 1mL/min nutrient flow rate. 
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Figure 3.5: Comparison of shear stress distribution long x-axis in Design 6, Design 7 and Design 8a at nutrient flow rate of 

1mL/min. a) Upper panel shows wall shear stress b) lower panel shows shear stress along x-axis. 
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Figure 3.6: Comparison at various thicknesses in Design 6, Design 7 and Design 8a, at 1mL/min nutrient flow rate. A) 

maximum velocities in Design 6, 7 and 8. B) maximum shear stress in Design 6. C) maximum shear stress in Design 7. D) 

maximum shear stress in Design 8. 
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3.3.2 Effect of flow rate on pressure drop and shear stress: 

The simulations for Design 6 were performed at 1 mL/min flow rate and then increased 

gradually to 20 mL/min to assess the effects on the differential pressure.  There was a non-linear 

increase in the pressure drop and shear stresses across the reactor in Design 6 with increase in 

flow rate.  However, in Design 7 and Design 8a the values of differential pressure and shear 

stress increased linearly with the increase in the flow rate.   

 

3.3.3 Effect of permeability on pressure drop and shear stresses: 

During tissue healing, permeability of the porous structure will change due to the de novo 

deposition of the ECM, the proliferation of cells and degradation of the porous structure.  To 

assess the effect of these changes in the scaffold, the pore size and porosity and hence the 

permeability values of the scaffold used in the simulations were decreased gradually.  

Comparisons were made at varying pore sizes up to 10µm for mimicking tissue regeneration at 

constant cell density.  In Design 6, the pressure drop increased with reduced permeability and 

was inversely proportional to 1/k, as predicted by the Brinkman equation.  However, there was 

no effect on the pressure drop across the reactor in Design 8a with reduced permeability.  The 

shear stresses increased in a nonlinear manner as the pore sizes decreased in Design 6.  However, 

the change was not as significant as the pressure drop. 

 

3.3.4 Steady state concentration profile of the nutrients: 

The rate law parameters for oxygen and glucose were used for analyzing nutrient 

consumption by smooth muscles cells.  These simulations were performed at the same cell 

density (1.2×10
12

 cells/m
3
).  The comparison was also performed by reducing the porosity of the 
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scaffold from 85% to 10% and by keeping all other parameters same.  Oxygen being the limiting 

reactant, the results were analyzed for oxygen distribution.  Oxygen concentration profiles were 

plotted at incremental elevations of 0.5 mm from the bottom of the scaffold for each design.  The 

concentration profiles of oxygen for Design6 (Figure 3.6) showed uniform distribution of 

nutrients for porosity of 85% as well as for 10%.  However, (Figure 3.7) the concentration of 

oxygen decreased remarkably throughout the scaffold in Design 7 as the porosity reduced from 

85 % to 10 %.  In Design 8a, the concentration profiles of oxygen inside the scaffold remained 

the same for porosities of 85 %and 10 %. 

These changes could be attributed to the altered convective characteristics in the new 

designs and the role of diffusion transfer in nutrient distribution.  To understand these alterations, 

Péclet number was calculated using the equation: 

𝑃𝑒 =  
𝐿.𝑉

𝐷
          (3.14) 

where L is the characteristic length, V is the velocity while D is the effective diffusivity of the 

nutrient.  Velocity was measured at the centre of the scaffold.  These results (Table 3.3) showed 

that in Design 7 the mass transfer inside the scaffold occurred both by convection as well as 

diffusion.  When the porosity is 85 %, convective mass transfer is dominant but when the 

porosity is reduced to 10 % diffusive mass transfer becomes dominant.  In Design 8a, the mass 

transfer inside the scaffold occurs primarily by diffusion as the scaffold is placed at a lower level 

and nutrients flow over it.  As a result the concentration profiles do not change when the 

simulations are performed using constant effective diffusivities even if the porosity is reduced. 
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Table 3.3: Péclet number at the middle of the scaffold at 1mL/min flow rate. 

 Porosity 
Distance from the bottom of the scaffold (mm) 

0.5 1.0 1.5 2.0 

Design 6 For all 168.37 191.413 168.377 - 

Design 7 
85% 15.5607 53.6701 101.3089 148.3770 

10% 15×10
-6

 25×10
-6

 66×10
-6

 34×10
-5

 

Design 8a 
85% 0.02 0.06 0.25 1.57 

10% 15×10
-6

 25×10
-6

 66×10
-6

 34×10
-5
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Figure 3.6: Oxygen concentration profile at porosity of 85 %for Design6, Design 7 and Design 8a at different thickness of the 

scaffold compared at 1mL/min of nutrient flow rate. 
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Figure 3.7: Oxygen concentration profile at porosity of 10%for Design6, Design 7 and Design 8a at different thickness of the 

scaffold compared at 1mL/min flow rate. 
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Since, as the earlier study (Devarapalli 2009) for Design 6 was carried out using 

constant diffusivity values, it becomes necessary to take diffusivity changes into 

consideration, as the porosity of the scaffold would change due to the growing tissue.  

These changes need to be accommodated into the simulation for better estimation of 

nutrient distribution inside the porous scaffold. 
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CHAPTER IV 
 

 

ASSESSING THE EFFECT OF DIFFUSIVITY CHANGES 

 

4.1 Introduction: 

 In the previous chapter, the mass transport in Design 8a was determined to be diffusion 

limited.  The diffusive process in a porous medium is affected by many factors, such as the 

molecular size of the nutrient, the presence of cells, the porosity and morphology of a scaffold 

(Zhou et al. 2010).  During tissue regeneration process, several additional parameters will change 

the diffusive environment of the construct (Leddy et al. 2004).  For example, the accumulation of 

newly synthesized extra cellular matrix reduces pore size of the scaffold, hindrance factor 

changes with pore size which will alter the effective diffusivity.  Hence, molecular diffusion can 

become a constraint by limiting the nutrient supply required for cell proliferation and 

extracellular matrix production in a scaffold. 

 Earlier simulations were performed using constant infinite diffusivity values based on 

Stokes-Einstein equation.  To account for diffusivity changes in the porous structure, diffusivity 

of glucose was measured experimentally using three different scaffolds of varying mass 

fractions.  Further, effective diffusivity was evaluated using Mackie-Mearer relationship for a 

broad range of pore sizes and void fractions.  Considering these changes in effective diffusivities, 
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simulations were performed using Design 8a in this study.  In addition, three new bioreactor 

designs were investigated to accommodate varying thicknesses of scaffolds and permeabilities.   

 

4.2 Experimental Analysis: 

4.2.1 Preparation of porous scaffolds: 

Three different concentrations of chitosan-gelatin solutions namely 0.5%-0.5% (wt/v), 

1%-1% (wt/v), 2%-2% (wt/v) were prepared in 0.1M acetic acid using deionized water.  Wells of 

100 mm diameter were prepared on Teflon sheets using silicon glue, and 25mL of respective 

solutions were poured in the wells and frozen overnight at -80
0
C.  The frozen solutions were 

lyophilized overnight (Virtis, Gardiner, NY).  The scaffolds formed from 0.5%-0.5% (wt/v) 

solutions has skinny layer on top which could be peeled off. For removing the skinny layer from 

scaffolds of 1%-1% (wt/v) and 2%-2% (wt/v) solution a wet paper was placed on the top of the 

solution, after pouring the solution inside the well, and was frozen along with the solution.  After 

lyophilizing the paper was peeled off to generate scaffold without the skinny layer. 

 

4.2.2 Characterization of pore size and pore number:  

Obtained scaffolds were analyzed in dry condition using scanning electron microscope 

(SEM, Joel JSM 6360) at an accelerating voltage of 10 kV.  For this purpose, small sections of 

dry scaffolds were sputter-coated with gold at 40mA prior to observing under SEM.  Captured 

digital micrographs from random locations are shown in Figure 4.1.  Morphologies of the 

scaffold were also characterized in hydrated condition using an inverted microscope (Nikon 

TE2000, Melville, NY) outfitted with a CCD camera.  Digital micrographs were captured and 

analyzed for pore area, major axis, minor axis and shape factor (defined as 4π × area/perimeter, 
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and when the number is closer to 1, the cell shape is closer to that of a circle) using Sigma Scan 

Pro 5 software.  For each condition, more than 50 pores were analyzed. 

The distributions of pore area, major axis, minor axis, and shape factor and were plotted 

as box plots to show the 10th, 25
th
, 50

th
, 75

th
, and 90

th
 percentiles and the mean value (thick line 

within each box).  Values that were outside 95
th

 and 5
th

 percentiles were treated as outliers.  

These results showed (Figure 4.2) that increased amount of chitosan and gelatin decreased the 

pore area, major axis, and minor axis.  However, shape factor was not affected as the shape of 

the pores is regulated by ice crystals. 

 

4.2.3. Estimation of Porosity: 

To determine the void fraction of the scaffold, 10 mm × 50mm strips were cut from each 

scaffold and the thickness was measured using Vernier calipers.  These strips were then weighed 

to get the dry weight and then washed with absolute ethanol to remove acetic acid.  In order to 

remove all the air bubbles from scaffold strips, they were cyclically pressurized and 

depressurized manually while keeping them immersed in ethanol.  These strips were weighed to 

find out their wet weight.  Void fraction of the structure was obtained by using formula: 

𝜀𝑝 =
𝑊𝑤𝑒𝑡 −𝑊𝑑𝑟𝑦

𝜌𝑒𝑡
× 100        (4.1) 

where Wwet is the weight of the ethanol wetted scaffold strips, Wdry is the weight of the dry 

chitosan-gelatin scaffold strips, ρet is the specific gravity of ethanol.  These results showed 

(Table 4.1) a reduction in the void fraction with increasing concentrations of polymers. 
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Table 4.1: Porosity of Chitosan-Gelatin scaffolds. 

Scaffold %Void fraction 

0.5%-0.5% (wt/v) 92 ± 0.9 

1%-1% (wt/v) 83±0.65 

2%-2% (wt/v) 77±0.4 
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Figure 4.1: SEM images of chitosan-gelatin porous structure A) 0.5%-0.5% (wt/v) B) 1%-1% (wt/v) C) 2%-2% (wt/v) 
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Figure 4.2: Box plot comparing pore area and pore size of 0.5%-0.5% (wt/v), 1%-1% (wt/v) and 2%-2% (wt/v) chitosan-

gelatin scaffolds. 
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4.2.4. Permeability analysis of scaffolds: 

Permeability analysis of chitosan-gelatin scaffolds was performed using glucose as the 

diffusing material, which is one of the nutrients.  A diffusion cell apparatus (Figure4.3) was 

constructed in-house.  The diffusion cell had two chambers, namely Chamber 1 that contained 

glucose solution of known concentration (50 gm/L) prepared in deionized water, and Chamber 2 

contained DI water.  Both the compartments contained exactly same volume of liquids (120 mL) 

during experiments and had a 3 mm diameter circular window for direct exposure of the 

scaffolds to the two solutions.  These chambers were joined together using paper clips and the 

different chitosan-gelatin scaffolds were mounted in-between.  The experiment was carried out at 

room temperature.  The procedure during the entire experiment is as follows: 

1) Hydrated Chitosan-Gelatin scaffold is mounted on one of the chambers.  Second chamber 

is then clamped to the first chamber.  

2) Known initial glucose concentration of 120 mL solution and 120 mL DI water were 

poured in Chamber 1 and Chamber 2, respectively.  Both the chambers were kept well 

mixed using magnetic stirrers.  Samples (100 µL) were taken from both the chambers 

after every 10 minutes for 1hour. 

3) The collected samples were diluted to 1:9 ratio in DI water, for preparing them for the 

glucose analysis using YSI-2700 Bio-scientific analyzer instrument.  

4) The instrument setup consists of a glucose standard solution, a glucose buffer solution, a 

sampling chamber and a dipper tube.  Glucose-oxidase membrane was used in YSI-2700 

Bio-scientific analyzer for determining glucose concentration.  The instrument needed to 

be calibrated every time when turned „ON‟.  After calibration, the instrument was setup 
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in automatic mode to pick one sample from the turntable and evaluate the glucose 

concentration. 

 

Figure 4.3: Schematic of diffusion cell  

Using the glucose concentrations from various time points, membrane permeability was 

calculated as described previously (Raghavan et al. 2005).  In brief, following equation was used 

assuming a quasi-steady state approximation 

𝑙𝑛  
𝐶0−2𝐶2

𝐶0
 =  −  

𝐴𝑚

𝑉
𝑃 𝑡       (4.1) 

where C2 is the concentration of the glucose measured at any time t in Chamber 2, C0 is the 

initial concentration in Chamber 1, Am is the membrane area (= 9/4 cm
2
, as the radius of the 

chamber is 3 cm), V is the volume of each chamber (= 120 mL), and P is the Permeability of the 
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matrix.  Then 






 

0

20 2
ln

C

CC
 was plotted as a function of time from which the slope (= V

PAm

) 

was determined using a linear fit.  The permeability (Table 4.2) was calculated using the slope 

values. 

Table 4.2: Permeability’s of various chitosan-gelatin scaffolds for glucose. 

Scaffold 
Permeability 10

6 

(m/s) 
Diffusivity 10

9
 (m

2
/s) 

Diffusivity 10
10

 (m
2
/s) 

(Mackie-Mearer 

Approximation) 

0.5%-0.5% 7.9±0.04 13.6±0.04 69.3 

1%-1% 2.0±0.06 7.2±0.06 48.0 

2%-2% 1.2±0.05 4.7±0.05 37.4 

 

However, it was noted that these experimental values of permeability and diffusivity for 

glucose through the chitosan-gelatin porous scaffold were an order of magnitude higher than the 

infinite diffusivity value calculated for glucose using Stokes-Einstein‟s equation.  Hence, to 

estimate the diffusion coefficient of glucose through chitosan-gelatin scaffold, Mackie-Meares 

relation was used. 
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4.3. Computational Simulation: 

4.3.1. Nutrient distribution in the reactor: 

As described in the previous chapter, Design 7 and Design 8ageometrieswere created 

using COMSOL Multiphysics 3.5a (COMSOL, Inc., Burlington, MA).  All simulations were 

performed under steady state conditions using similar boundary conditions and governing 

equations expect the diffusivity values.  

The diffusivity of molecules through the porous structure is given by Mackie-Meares 

equation (Mackie and Meares 1955; Sengers et al. 2005). 

𝐷𝑒𝑓𝑓 = 𝐷∞  
∅

2−∅
 

2
         (4.2) 

where, Deff is the effective diffusivity, D∞ is the infinite diffusion coefficient of the solute from 

Stokes-Einstein equation and Φ is the porosity of the scaffold. 

4.3.2. Importance of changes in diffusivity considerations on nutrient transport: 

Using the effective diffusivity values for oxygen and glucose, simulations were 

performed.  Comparison of oxygen distribution in Design 8a with and without diffusivity 

changes, showed significant differences (Figure 4.4) for a case of 50% void fraction.  

Simulations performed using free diffusivity showed no significant differences in oxygen 

concentration different elevations within the porous structure.  However, simulations performed 

using effective diffusivity showed considerable changes in oxygen concentration at different 

elevations in the same reactor configuration.  This confirmed the notion that Design 8a is 

diffusion limited. 
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Figure 4.4: Comparison between concentration profiles of oxygen in Design 8a at 50 µm pore size and 50% porosity by using 

A) Free diffusivity  B) Effective diffusivity calculated using Mackie-Meares relationship. 
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4.3.3 Understanding the effect of changing porosity on regenerating tissue: 

 To evaluate the effect of porosity changes during regeneration, simulations were 

performed in Design 7 and Design 8a by progressively decreasing the pore size and porosity of 

the scaffold, i.e., in-turn decreasing the diffusivity of the nutrients according to the Mackie-

Meares relation.  The pressure drop and shear stress changes are expected to be similar to those 

observed in the previous chapter.  Hence, they are not shown here.  Significant changes in 

concentration of oxygen and glucose were observed at different elevations in the scaffold, similar 

to Figure 4.5.  To better understand these changes, minimum concentrations were determined in 

each simulation and plotted for various permeabilities.  

 

Figure 4.5: Effect of changing porosity on minimum O2 concentration and glucose in 

Design 7 and Design 8a at flow rate of 1mL/min and pore number of 140/mm
2
. A) oxygen, 

B) glucose. 

Both Design7 and Design 8a showed comparable reduction in oxygen and glucose 

concentrations, with the reduced porosity.  The minimum concentration of nutrients reduced 

drastically as the porosity of scaffold reduced further lower than 20 %. Since scaffold edges are 
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exposed to direct fluid flow in Design, the quality of the regenerated tissue could decrease.  

Hence, Design 7 was not explored in subsequent analyses. 

4.3.4 Understanding the effect of scaffold thickness: 

Next, the effect of scaffold thickness was evaluated to understand at what thickness of the 

scaffold the concentration of oxygen approaches zero.  Design 8a was modified to a 4 mm thick 

scaffold (Design 8b), and 6 mm thick scaffold (data not discussed) with all other configurations 

unchanged (Figure 4.6).  These simulations showed that, the minimum oxygen concentration 

approached near zero value in Design 8b when the porosity was reduced to 50%.  The difference 

in oxygen concentration profiles at various elevations for Design 8b at 85% porosity and 50 % 

porosity are shown in Figure 4.7.  Also to check the effect of healing tissue, the pore size and 

porosity were decreased progressively.  These results showed that the bioreactor configuration 

with only one channel is insufficient to provide nutrients during tissue regeneration.  Hence, 

alternative configurations had to be explored.  

 

Figure 4.6: Schematic of Design 8b (gray region signifies the location of scaffold) 
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Figure 4.7: Oxygen concentration profiles in Design 8 for 4 mm thick scaffold compared at 1mL/min flow rate for A) 85% 

porosity B) 50% porosity 
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4.3.5Assessing the effects of channel location: 

 Design 8 was modified to understand the effects of having the flow of nutrients from both 

sides of the scaffold, which would reduce the distance through which nutrients have to diffuse by 

half.  This change in design corresponded to two parallel channels with scaffold sandwiched in 

between.  Two modifications (Design 9 and Design 10) were evaluated,  

In Design 9 (Figure 4.8), two separate inlets and outlets were incorporated with two 2 

mm thickness channels on opposite sides.  Three different thicknesses namely 2 mm (Design 9a), 

4 mm (Design 9b) and 6 mm thicknesses were also evaluated  

 

Figure 4.8: Schematic of Design 9 (gray region signifies the location of scaffold) 

For practical purposes, placing the reactor horizontal may be important.  For this purpose 

(Figure 4.9), another design (Design 10) with one inlet and one outlet but branching into two 

stream for the two channels of 2 mm thickness was considered.  Similar to Design 9, three 

scaffold thicknesses namely 2 mm (Design 10a), 4 mm (Design 10b) and 6 mm thicknesses were 

evaluated.  
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Figure 4.9: Schematic of Design 10 (gray region signifies the location of scaffold) 

At 1 mL/min flow rate and varying porosity values, the simulations showed comparable 

minimum oxygen concentration and minimum glucose concentration (Figure 4.10) values for 

Design 9a and Design 10a.  Design 9a had pressure drop and maximum shear stress values of 24 

mPa and 112.5 µPa, respectively whereas Design 10a had pressure drop and maximum shear 

stress values of 28 mPa and 105 µPa.  It can be seen that the there is not much difference in the 

results.  Hence, only Design 10 was considered for further analyses. 
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Figure 4.10: Effect of changing porosity on minimum nutrient concentration with 

140pores/mm
2
 and at flow rate of 1mL/min A) oxygen, B) glucose. 

When scaffold thickness was increased to 4 mm (Design 10b), uniform nutrient distributions 

(Figure 4.11) were observed at various locations with 1 mL/min flow rate.   
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Figure 4.11: Oxygen concentration profiles in Design 10b (4 mm thick scaffold) compared at 1mL/min flow rate for A) 85% 

porosity B) 50% porosity 



59 
 

4.3.6Assessing the effects of channel height: 

Adding 2 mm channels on both sides necessitates significant increase in the hold-up 

volume of expensive growth medium.  One way to reduce the hold-up volume is to decrease the 

channel height.  To test the effect of the changing the channel height, the new design (Design 11) 

had 1 mm thickness on both sides (Figure 4.12).  This would reduce the hold-up volume of the 

nutrient media to that in Design 8, without compromising on the effectiveness of the reactor 

design.  As before, two scaffold thicknesses namely 2 mm (Design 11a) and 4 mm (Design 11b) 

were evaluated.  

 

Figure 4.12 Schematic of Design 11 (gray region signifies the scaffold location) 

These results showed no significant changes in nutrient concentrations for Design 11a 

and Design 10a.  However, the pressure drop value increased to 156 mPa in case of Design 11 

from 24 mPa in case of Design 10.  Even the shear stress values along x-direction increased to 

446 µPa for Design 11 from 112 µPa for Design 10.  Further, the simulation were run for 4mm 

scaffold i.e. for Design 11b and the minimum oxygen concentration results were compared to the 
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results of Design 8b in Figure 4.13 and tabulated in Table 4.3.  It was observed that Design11b 

had slightly higher pressure drop and shear stress values, while having better nutrient 

concentration profiles and higher „minimum oxygen concentration‟ inside the scaffold than 

Design 8b. 

 

Figure 4.13: Effect of changing porosity on minimum oxygen concentration in Design 8b 

and Design 11b with 140pores/mm
2
 and at flow rate of 1mL/min.
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Table 4.3: Comparison between Design 8b and Design 11b (4 mm scaffold) at various pore sizes and porosity and at 

140pores/mm
2
pore number, (1.2×10

12
 cells/m

3
) and 1mL/min flow rate. 

Pore 

size 

(μm) 

Porosity 

(%) 

Hydraulic 

Permeability 

10
10

(m
2
) 

Oxygen 

Diffusivity 

10
10

 (m
2
/s) 

Design 8b Design11b 

Minimum 

Oxygen 

concentration 

(µM) 

Shear stress 

(μPa) Pressure 

drop (Pa) 

Minimum 

Oxygen 

concentration 

(µM) 

Shear stress 

(μPa) Pressure 

drop 

(Pa) Along 

x-axis 

Along 

y-axis 

Along 

x-axis 

Along 

y-axis 

80 85 1.407 11.94 83 203.1 119.5 0.0489 127 389.5 233.5 0.156 

80 70 1.407 6.33 55 203.1 119.5 0.0489 112 389.5 233.5 0.156 

50 50 0.2147 2.43 18 203.5 119.4 0.0489 74 391.1 235.3 0.156 

20 20 0.005497 0.27 0.004 203.5 119.4 0.0489 3.34 391.6 237.9 0.156 

10 10 0.000343 0.06 0 203.5 119.4 0.0489 0 373.37 220.83 0.156 
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4.5.7 Assessing the effects of cell density: 

Regeneration of tissue will cause the initial number of cells to increase, as the 

cells multiply.  To access the effect of this increase in cell density on nutrient 

consumption, pressure drop and shear stress, simulations were performed on Design 11 

by increasing the initial cell density of SMCs.  The flow rate was kept constant at 

1mL/min.  Simulations were run for 2mm as well as 4mm scaffold thickness.  These 

results (Table 4.4) showed that the minimum oxygen concentration reduced drastically 

with decreasing permeability at constant cell density.  Insufficiency of oxygen 

concentration is reached at 10 μm pore size and 10 % porosity for a 2 mm scaffold.  

Whereas for a 4 mm scaffold, minimum oxygen concentration drops to zero at 20 μm 

pore size and 20 % porosity value.  In addition, it was seen that the pressure drop across 

the reactor as well as the shear stress values did not change due to the change in cell 

density. 
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Table 4.4: Comparison between Design 11a (2mm scaffold) and Design 11b (4 mm scaffold) at various pore sizes and porosity 

and at constant cell number, 140pores/mm
2
pore number and 1 mL/min flow rate. 

Pore 

size 

(μm) 

Porosity 

(%) 

Hydraulic 

Permeability 

10
10

(m
2
) 

Oxygen 

Diffusivity 

10
10

 (m
2
/s) 

Design 11a (2 mm scaffold, 

2.4×10
12

cells/m
3
) 

Design11b (4 mm scaffold, 1.2×10
12

 

cells/m
3
) 

Minimum 

Oxygen 

concentration 

(µM) 

Shear stress 

(μPa) Pressure 

drop (Pa) 

Minimum 

Oxygen 

concentration 

(µM) 

Shear stress 

(μPa) Pressure 

drop 

(Pa) Along 

x-axis 

Along 

y-axis 

Along 

x-axis 

Along 

y-axis 

80 85 1.407 11.94 133 203.1 119.5 0.0489 79.8 389.5 233.5 0.156 

80 70 1.407 6.33 125 203.1 119.5 0.0489 63.5 389.5 233.5 0.156 

50 50 0.2147 2.43 102 203.5 119.4 0.0489 32.4 391.1 235.3 0.156 

20 20 0.005497 0.27 15 203.5 119.4 0.0489 0 391.6 237.9 0.156 

10 10 0.000343 0.06 0 203.5 119.4 0.0489 0 373.37 220.83 0.156 
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4.4 Discussion: 

 In this study, changes in diffusivity due to the process of To account for changes 

in diffusivity values due to changes in porosity of the scaffold, glucose diffusivity 

experiments were carried out using scaffold of three different compositions and hence 

three different porosity values.  Since these values of diffusivities were determined to be 

a magnitude higher than, effective diffusivity, the diffusion coefficient of nutrients 

through the porous scaffold was calculated using Mackie-Meares equation.  These 

effective diffusivity values were then incorporated into the simulations and the results 

compared.  The results showed a fall in concentration profiles of nutrients for same 

reactor configuration when compared by keeping other parameters constant.  

 Further, the effectiveness of Design 8 was tested for a 4 mm scaffold (Design 8b) 

and minimum concentration of oxygen was checked as oxygen is the limiting reactant.  It 

showed that the minimum concentration of oxygen approached zero when the porosity of 

scaffold was decreased to 50 %, meaning this configuration of reactor would not support 

a 4mm thick growing tissue.  So, in order to provide sufficient nutrients to the growing 

tissue of 4mm thickness, two new reactor configurations were explored.  This first 

modification was named as Design 9 which was provided with two channels having 2 

mm thickness each and which had two separate inlets and outlets for both the channels.  

This design gave better results for the minimum oxygen concentration even for the 4mm 

reactor (Design 9b) when the porosity values were lowered as compared to Design 8b.  

However, the Design 9b was not considered for further analysis because of practical 

reasons of handling and mounting.  Design 10 with single inlet and outlet split into two 

streams which provided the flow to both parallel channels was studied and it was found 
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that the results obtained for Design 9a and Design 9b were similar to Design 10a and 

Design 10b.   

 For being consistent with the amount of nutrient media „Hold-up‟ volume inside 

reactor, a new configuration, Design 11, was developed which had two channels each of 

thickness 1 mm.  The simulation results of this design were at par with Design 10 and 

were far better than Design8.  Also, it was seen that the pressure drop across Design 11 

increased a little to 0.156 mPa and the shear stresses along the reactor also had a higher 

value than values for Design 8.  Thee slightly increased shear stress value could be 

beneficial for the cell as seen by the researchers cited in this study. 
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CHAPTER V 
 

 

CONCLUSIONS AND RECOMMENDATIONS 

 

5.1  CONCLUSIONS 

 This study used a circular shaped parallel plate split flow reactor and evaluated 

different design for regenerating high aspect ratio tissue of 100 mm diameter and varying 

in thickness from 2 mm to 4 mm.  The bioreactor system studied can be used for 

developing clinical grade skin and bladder tissues.  Conclusions from the study are 

summarized as below according to the two specific aims. 

Specific Aim 1: To determine alternate design for a flow through bioreactor. 

1. To understand flow characteristics in flow through reactor configuration, 

simulations of Design 6 and two new designs (Design 7 and Design 8) of the 

circular shaped reactor were performed using COMSOL Multiphysics 3.5a 

(COMSOL, Inc., Burlington, MA).  Design 7 had greater overall thickness than 

Design 6, whereas Design 8 had a scaffold placed inside a cavity like 

arrangement.  Analysis of Design7 and Design 8, suggested that, both the designs 

had a far lesser pressure drop as compared to Design 6. 

2. When Design 7 and Design 8 were compared, Design 7 has a slightly higher 

pressure drop value than Design 8.
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3. The comparison of shear stresses along the reactors showed that, Design 6 gave 

the highest shear stress value as compared to Design 7 and Design 8.  The shear 

stress values of Design 7 and Design 8 were similar.  The spikes in sheer stress 

plot of Design 8 can be attributed to the change in the cross section area in that 

region.  Also, when the pore size and porosity was reduced to mimic the cell 

growth and extracellular matrix formation, the pressure drop and shear stress 

values for both Design 7 and Design 8 did not change. 

4. After calculating Peclet number, it was found that through the scaffold in Design 

6 was convection dominant.  Nutrient transport through scaffold in Design 7 

occurred due to convection as well as diffusion, when the porosity of the scaffold 

was high.  However, when the porosity of the scaffold was lowered, the flow 

through scaffold becomes diffusion dominant.  While, for Design 8 the flow 

through the scaffold is always diffusion dominant.  As diffusive mass transfer 

plays an important role in nutrient distribution, it was necessary to account for the 

changes in diffusivity values that would occur due to tissue regeneration. 

 

Specific Aim 2: To assess the effect of diffusivity changes on nutrient transport. 

Permeability experiments were carried out in a diffusion cell apparatus which was 

built in-house.  The values of the diffusion coefficient for glucose from these experiments 

were an order of magnitude higher than the infinite diffusion coefficient of glucose.  So, 

the effective diffusion coefficients of nutrients were calculated using Mackie-Meares 

relation which estimates the diffusion of solutes through porous media.  



68 
 

1) Simulations for Design 8 using infinite diffusivity values and diffusivity values 

from Mackie-Meares relation showed differences in concentrations profiles of 

nutrients.  It can be said that the simulations using Mackie-Meares approximation 

for diffusivity predict the nutrient distribution in a better way. 

2) Further it was seen that for a 4mm scaffold in Design 8, the minimum 

concentration of oxygen reduced drastically for lower values of pore size and 

porosity. So, two new designs Design 9 and Design 10, with two parallel channels 

were considered.  The two channels system in these designs reduced the length 

through which nutrients have to.  Though, Design 9 and Design 10 gave similar 

results, Design 9 was not considered further because of practical reasons of 

handling and mounting complications.   

3) For a comparison with Design 8, Design 11 was considered to keep the reactor 

„Hold-up‟ volume same as with Design 8, without compromising on the 

effectiveness of the design.  This modification, Design 11, had two channels of 

thickness 1mm each, which fed the scaffold.  Design 11b had slighter higher shear 

stress pressure drop values owing to reduction in thickness of the channel.  When 

the results of nutrient distribution in Design 8 and Design 11b were compared, the 

results of Design 10b were better. 

5.2 RECOMMANDATION: 

1) This study was done using only one cell type.  The simulation results should be 

checked for other cell types too and the effective of designs should be validated. 

2) Oxygen solubility is nutrient media is less as compared to other nutrients, so 

oxygen acts as a limiting reactant in cell culture studies.  However, solubility of 
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oxygen can be increased by increasing the partial pressure inside the nutrient 

media.  For achieving this, oxygen can be bubbled through the media while 

maintaining the reactor at a pressure higher than atmospheric.  Further, 

simulations should be performed to check the effect of this increased solubility on 

nutrient distribution. 

3) These bioreactor designs have been studied theoretically, and simulations are 

performed by taking different factors into account.  However, these reactors 

should be built and cell culture should be carried out for the purpose of 

experimental validation. 

4) To see the effect of pressure drop and shear stress on the scaffold and on 

regenerating tissue, mechanical properties of the scaffold should be incorporated 

into the simulations. 

5) To check the effect of different variables in the simulation, sensitivity analysis 

needs to done. 

6) Using this reactor design it can be predicted that a circular tissue consisting of 

smooth muscles cells and having diameter of 100mm and 4 mm thickness can be 

grown.  For any further increase in thickness better means of distributing nutrients 

to growing cells like incorporating blood vessels should be looked into.  This can 

be done by having smart designed scaffolds which would have micro scale 

capillaries depicting blood vessels. 
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APPENDIX A 

DETERMINATION OF DIFFUSIVITY OF GLUCOSE THROUGH CHITON-

GELATIN SCAFFOLDS 

 

A 1 Introduction: 

 It was observed from the simulation results that the diffusivity of nutrients 

through the porous structure will play an important role in nutrient distribution 

throughout the scaffold.  Diffusivity of nutrients through the scaffold is affected by the 

porosity of the scaffold.  Hence, to quantify the relation between diffusivity of nutrients 

and porosity of scaffold, diffusion experiments were conducted by using 3 scaffolds of 

different compositions.  The conditions for the experiment are as tabulated in Table A 1 

Parameter value 

Temperature room temperature 

(25
0
C) 

Pressure atmospheric 

Glucose concentration 50gm/L 

Chitosan-gelatin 

Scaffold porosity (%) 

1) 0.5%-0.5% (wt/v) 92 

2) 1%-1% (wt/v) 83 

3) 2%-2% (wt/v) 77 

Volume of liquid in each chamber  120mL 
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A.2Experiment: 

A.2.1 Procedure: 

The setup of the experiment is as shown in the Figure A.1.  The procedure during the 

entire experiment is as follows: 

1) Hydrated Chitosan-Gelatin scaffold is mounted on one of the chambers. Second 

chamber is then clamped to the first chamber.  

2) Known initial glucose concentration of 120 mL solution and 120 mL DI water 

were poured in Chamber 1 and Chamber 2, respectively. Both the chambers were 

kept well mixed using magnetic stirrers.  Samples (100 µL) were taken from both 

the chambers after every 10 minutes for 1hour. 

3) The collected samples were diluted to 1:9 ratio in DI water, for preparing them for 

the glucose analysis using YSI-2700Bio-scientific analyzer instrument.  

4) The instrument setup consists of a glucose standard solution, a glucose buffer 

solution, a sampling chamber and a dipper tube. Glucose-oxidase membrane was 

used in YSI-2700Bio-scientific analyzer for determining glucose concentration.  

The instrument needed to be calibrated every time when turned „ON‟.  After 

calibration, the instrument was setup in automatic mode to pick one from the 

turntable and evaluate the glucose concentration. 
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Using the glucose concentrations from various time points, membrane 

permeability was calculated as described previously (Raghavan et al. 2005).  In brief, 

following equation was used assuming a quasi-steady state approximation 

𝑙𝑛  
𝐶0−2𝐶2

𝐶0
 =  −  

𝐴𝑚

𝑉
𝑃 𝑡      (A.1) 

whereC2 is the concentration of the glucose measured at any time t in Chamber 2, C0 is 

the initial concentration in Chamber 1, Am is the membrane area (= 9/4 cm
2
, as the 

radius of the chamber is 3 cm), V is the volume of each chamber (= 120 mL), and P is the 

Permeability of the matrix.  Then 






 

0

20 2
ln

C

CC
 was plotted as a function of time from 

which the slope (= V
PAm

) was determined using a linear fit.  The permeability was 

calculated using the slope values. 

A.2.2 Sample experimentation values: 

 The samples are analyzed for glucose concentration using YSI-2700Bio-scientific 

analyzer instrument.  The values of glucose concentration, for example 1%-1% chitosan-

gelatin scaffold, are tabulated as shown Table A.2. 

Time C1 (gm/lit) C2 (gm/lit) 

0 4.52 0 

10 4.51 0.01 

20 4.49 0.023 

30 4.475 0.041 

40 4.44 0.073 

50 4.4 0.103 

60 4.38 0.131 

Table A.2 Glucose concentrations in chamber 1 and chamber 2. 



 
 

APPENDIX B 

METHOD OF PORE AREA MEASUREMENT 

This is a quick guide for measuring area of pore area Sigma Scan Pro5.  

B.1 Pore Characterization: 

Assuming we have taken a micrograph at a 10X resolution. 

1) Open “Sigma scan pro” software → open the Hemocytometer 10X image → 

(follow path) Image→ calibrate→ Distance and area. 

 

2) A window will pop up. In that window select “2-point calibration”. Set old 

distance=250 and new distance = 388. (or you can set the new distance even by 

clicking on the adjacent vertices of the hemocytometer square)  



 
 

 

3) Now, without closing the „Hemocytometer 10X‟ image, open the your correct 

„Micrograph image file‟. Go to „Image→ Calibrate→ Copy Calibrations…‟ 

 

4) A window will pop up. Copy calibrations from „Hemocytometer 10X‟ to your 

„Micrograph image file‟. 
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5) Select „Trace mode→ demarcate the area of the pore by clicking along its 

perimeter → once you reach your starting point, right click will highlight the area 

in „red‟ color. 

 

 

6) Then go to→ Measurements→ Measure objects→ a window will pop up. Click 

OK. 
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7) You will see an output excel file when you minimize the image window. 

 

 

 



 
 

APPENDIX C 

COMSOL MANUAL 

This is a quick guide to COMSOL Multiphysics 3.5a. 

C.1.1 Creating geometry: 

1. Start > All Programs > COMSOL 3.5a > Click on COMSOL Multiphysics 

3.5a. Model Navigator window will pop up. 

2. In Model Navigator >Set Space Dimension as 3D 

3. In the Application Modes section Click on Chemical Engineering Module >Fluid-

Chemical Reactions Interaction>Reacting Flow> Select Steady State Analysis. 

Click OK. COMSOL Multiphysics Window will pop up. 



 
 

4. Select Draw tab > Click on Work Place Settings. Work plane settings window 

will pop up.  

 

5. Select Quick tab > Check on x-y and set z = 0. Click OK. 

6. Select Draw tab> Draw Objects > Click on Ellipse/ Circle (centered) and create 

a circle in the Model View. To draw a circle Select a point in the model view and 

move the mouse to some extent and then click the left button of the mouse once. 

7. To Change the dimensions of the object created (say Circle), double click on that 

particular object a window will pop up. In Size section>Change A semi-axes: 0.5; 

Change B semi-axes: 0.5. Leave the rest as it is. 

8. Click on Geom2 tab in the Model View. Repeat Step 6 and create a circle in the 

Fourth quadrant (i.e.; quadrant in which both x & y are negative).  
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9. Repeat Step 7 to Change the dimensions of the circle. In size section > Change A 

semi-axes: 0.003 and B semi-axes: 0.003. In the Position Section> Change x: -

0.028 and y: - 0.028. (This is to create the inlet of 6mm diameter for the circular 

reactor). 

The complete 2D figure can be seen as below. 

 

10. To extrude 2D Geometry object to 3D.  Select the object that is to be extruded.( In 

our Case, it is the circle) 

11. In the Menu bar Select Draw> Extrude. A window will pop up. 

12.In the Extrusion parameters section > Change Distance: 0.002. Leave the rest as it 

is for Straight Extrusion. Click OK. In the Model View> Geom1 Tab a circle with 

diameter 10cm and thickness of 2mm will be seen. 
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13. Repeat Step 9 to extrude. In the Extrusion parameters section > Change Distance: 

0.01. Click Ok. In the Model View> Geom1 tab an inlet of 1cm length with a 

diameter of 6mm is extruded. 

14. The circular parallel plate split flow reactor is created. 

 

C.1.2 Creating constants list: 

Creating a constants list is safe and an easier way to input the parameters which 

might be used multiple times while writing the boundary conditions. 

1. In the Menu bar > Select Options > click on Constants. A window will pop up. 

2. In the window that pops up.  There will be four columns. Name, Expression, 

Value and Description.  In the Name column type in the name for the parameter. 

For example, density can be named as rho.  In the Expression column enter the 

values of the constant with units. And then Click Enter the Value will be 
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automatically shown in the Value column. In the Description column we can 

write comments for the users to understand about a particular constant. 

3. Input the below data in the Constants window that pops up. ( the below values are 

for water flowing through the circular parallel plate split flow reactor having 

chitosan-gelatin porous structure with 140pores/mm2 , 80um pore size and the 

volumetric flow rate maintained is 1 mL/min). 

 

Click OK. 

C.1.3 Setting up subdomain and boundary conditions for fluid flow: 

C.1.3.1 Subdomain settings: 

1. In the Model tree > right click on Incompressible Navier Stokes (chns)> Click on 

Subdomain Settings. A window will pop up. 

2. Select subdomain tab> In the subdomain selection> select all the domains 

defining fluid filled region in the reactor. 

3. Select the physics tab and Input the fluid properties. For ρ: Input the constant rho.  

Similarly for η: input the constant eta. Leave the remaining as it is.  
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4. Next in subdomain selection>select all domains defining porous region in the 

reactor>Check on the flow in porous media (brinkman equation) option. Input for 

k the constant K. 

 

5 Click OK. 

C.1.3.2 Boundary settings: 

1. In the Model tree > right click on Incompressible Navier Stokes (chns)> Click on 

Boundary Settings. A window will pop up.  In the Boundary tab > Select 11. (it is 

the inlet Boundary) 

2. Select the coefficients tab>Boundary condition: Select velocity. Change w0 value 

from 0 to w0. 

3. In Boundaries tab> select 63 ( it is the outlet Boundary) 

4. Select the coefficients tab> Boundary condition: select normal flow, pressure. Set 

P0 to 0. 
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Click OK 

C.1.4 Setting subdomain and boundary conditions for reaction: 

C.1.4.1 Subdomain settings: 

1 In the Model tree > right click on Convection and diffusion (chcd) > Click on 

Subdomain Settings. A window will pop up. 

2. Select subdomain tab > In subdomain selection> select all the domains defining 

fluid filled region in the reactor. 

3. Select c1 >Input the diffusivity value.  Similarly input diffusivity value for c2.  Set 

R as 0, and u, v and w as u, v and w. 
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4. Next in subdomain selection>select all domains defining porous region in the 

reactor>c1>Input reaction rate equation [-V_o*c1/(Km_o+c1)] for R.  Similarly 

for c2, Input reaction rate equation [-V_g*c2/(Km_g+c2)]. 

 

5. Click OK. 

 

C.1.4.2 Boundary settings: 

1. In the Model tree > right click on Convection and diffusion (chcd) > Click on 

Boundary Settings. A window will pop up.  In the Boundary tab > Select 11 (it is 

the inlet Boundary) 

2. Select the coefficients tab> Boundary condition: Select Concentration. Input c10 = 

0.199 and c20 = 5.5. 
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3. In Boundaries tab> select 63 (it is the outlet Boundary) 

4. Select the coefficients tab > Boundary condition select convective flux for both c1 

and c2. 

Click OK 

C.1.5 Meshing of the geometry: 

1. In the Menu bar > Select Mesh > Free Mesh Parameter. A window will pop up. 

2. Select Edge tab > select the edges of input and output > Distribution tab > Under 

number of edge elements input 3 > click mesh selected. 

3. Select Boundary tab > select the boundary 11 and 63 > click mesh selected to 

mesh those boundaries. 
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4. Select Mesh tab> swept mesh parameters > select domain 3 and 12 > Elemental 

layer > check manual specification of elemental layers > 6 > click mesh selected. 
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5. Again using Boundary tab in Free mesh parameters, select the topmost 

boundaries of the reactor > input maximum element size as 0.005 > mesh 

selected. 

 

6. Select Mesh tab > swept mesh parameters > select the subdomains particular to 

the boundaries meshed > Elemental layer > check manual specification of 

elemental layers > 2 > click mesh selected. 

7. Using swept mesh parameters adjacent subdomain > select sweep direction tab > 

check Manual specification of sweep direction > select source faces and target 

faces > mesh selected. 
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C.1.6Setting up the solver: 

1. Go to Solve tab in the Menu bar. Click on Solve Parameters > A window will 

popup. 

2. In the Analysis section select Stationary. Select the solver as Stationary. 

3. Go to General tab >Linear system solver: Direct (PARDISO). 
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4. Leave the rest as same. Click OK. 

5. Select the solver according to the requirement. 

6. Go to Solve tab > Click on Solver Manager. A window will pop up. 

7. Select initial value tab> check mark on Initial value evaluated using current 

solution. In the Values of variables not solved for and linearization point 

section > 

Select Stored Solution. 

8. Click on Solve for tab> Select Incompressible Navier-Stokes (Chns) 

9. Undo Select for Convection and Diffusion and also Undo select for Geom2 

(2D). 

10. Click Solve. 
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11. After the Solver runs and solves for Navier Stokes equation. Click on Solve tab 

> Solver manager. Select > Initial value tab. Click on stored solution button. 

Check on stored solution. Select solve for tab > select Convection and diffusion 

and 

then Click Solve. 

C.1.7Post processing the results: 

1. Go to Post Processing tab in the Menu bar> Click on Plot parameters. A 

window 

will pop up. Select Subdomain tab. 

2. Predefined quantities> select Pressure  

3. Click OK. 
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